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i-Tree is a cooperative initiative



i-Tree is a state-of-the-art, peer-reviewed software suite from the USDA Forest Service 
that provides urban and community forestry analysis and benefits assessment tools. The 
i-Tree tools help communities of all sizes to strengthen their urban forest management 
and advocacy efforts by quantifying the environmental services that trees provide and 
assessing the structure of the urban forest. 

i-Tree has been used by communities, non-profit organizations, consultants, volunteers, 
and students to report on the urban forest at all scales from individual trees to parcels, 
neighborhoods, cities, and entire states. By understanding the local, tangible ecosystem 
services that trees provide, i-Tree users can link urban forest management activities with 
environmental quality and community livability. Whether your interest is a single tree or an 
entire forest, i-Tree provides baseline data that you can use to demonstrate value and set 
priorities for more effective decision-making.

Developed by USDA Forest Service and numerous cooperators, i-Tree is in the public 
domain and available by request through the i-Tree website (www.itreetools.org). The Forest 
Service, Davey Tree Expert Company, National Arbor Day Foundation, Society of Municipal 
Arborists, and the International Society of Arboriculture have entered into a cooperative 
partnership to further develop, disseminate, and provide technical support for the suite.

i-Tree Products

The i-Tree software suite v 3.0 includes two flagship urban forest analysis tools and three 
utility programs.

i-Tree Eco provides a broad picture of the entire urban forest. It is designed to use field 
data from randomly located plots throughout a community along with local hourly air 
pollution and meteorological data to quantify urban forest structure, environmental effects, 
and value to communities.

i-Tree Streets focuses on the ecosystem services and structure of a municipality’s street 
tree population. It makes use of a sample or complete inventory to quantify and put a 
dollar value on the trees’ annual environmental and aesthetic benefits, including energy 
conservation, air quality improvement, carbon dioxide reduction, stormwater control, and 
property value increases. 

i-Tree Species Selector is a free-standing utility designed to help urban foresters select 
the most appropriate tree species based on environmental function and geographic area.

i-Tree Storm helps you to assess widespread community damage in a simple, credible, 
and efficient manner immediately after a severe storm. It is adaptable to various 
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community types and sizes and provides information on the time and funds needed to 
mitigate storm damage.

i-Tree Vue (Beta) allows you to make use of freely available national land cover data 
maps to assess your community’s land cover, including tree canopy, and some of 
the ecosystem services provided by your current urban forest. The effects of planting 
scenarios on future benefits can also be modeled. This program is a beta version, i.e., it is 
still in development and feedback is appreciated.

Disclaimer

The use of trade, firm or corporation names in this publication is solely for the information 
and convenience of the reader. Such use does not constitute an official endorsement or 
approval by the U. S. Department of Agriculture or the Forest Service of any product or 
service to the exclusion of others that may be suitable. The software distributed under the 
label “i-Tree Software Suite v. 3.0” is provided without warranty of any kind. Its use is 
governed by the End User License Agreement (EULA) to which the user agrees before 
installation.

Feedback

The i-Tree Development Team actively seeks feedback on any component of the project: 
the software suite itself, the manuals, or the process of development, dissemination, 
support, and refinement. Please send comments through any of the means listed on the 
i-Tree support page: http://www.itreetools.org/support/. You can also use the Report a Bug 
feature available under the Help menu right in the software itself. User feedback will allow 
these tools to be updated and improved!



i-Tree

Components of the i-Tree software suite have been developed over the last few decades 
by the USDA Forest Service and numerous cooperators. Support for the development and 
release of i-Tree v. 3.0 has come from USDA Forest Service Research, State and Private 
Forestry, and their cooperators through the i-Tree Cooperative Partnership of Davey Tree 
Expert Company, National Arbor Day Foundation, Society of Municipal Arborists, and the 
International Society of Arboriculture. 
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i-Tree Vue (Beta) was conceived and developed by Alexis Ellis (US Forest Service 
Northern Research Station), Mike Binkley (the Davey Institute) and David J. Nowak (US 
Forest Service Northern Research Station). The manual was edited and designed by 
Kelaine Vargas.
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Introduction
i-Tree Vue (beta), a free-standing utility still in development, is the newest component of the 
i-Tree suite. It allows you to make use of freely available national land cover data maps to 
assess your community’s tree canopy cover and some of the ecosystem services provided 
by the urban forest. The effects of different planting scenarios on future benefits can also be 
modeled.

The best way to gain an understanding of your community’s urban forest and to lay the 
foundations for good stewardship is to gather real data in the field, including tree species, 
size, and health; i-Tree Eco and i-Tree Streets are the i-Tree components to help you do 
that. Sometimes, however, a broad estimate of canopy and tree-related benefits is helpful, 
either as a first step towards a greater understanding or because time and financial 
resources are limited. Vue was designed for just this situation.

i-Tree Vue offers the following advantages:

It provides a broad estimate of tree canopy, air pollution removal, carbon storage and 
annual carbon sequestration for the contiguous United States. 

No field data are required.

Canopy cover and ecosystem services are presented in spatial terms, so you can 
visualize how they vary across your community.

The effects of different planting scenarios on the future urban forest can be visualized. 

GIS-ready datasets can be created, but no GIS software or skills are needed. 

Vue does have several limitations, however, that should be kept in mind. These are related 
to the data source (2001 land cover maps with limited resolution) and the use of state and 
national averages for air pollution removal and carbon sequestration. These limitations are 
discussed in more detail in the Appendix.  

About This Manual

This manual provides all the information needed to conduct a Vue project. We start with 
installing the software and move on to the two project phases:

Phase I: Getting started. In this section, we describe how to gather the free National 
Land Cover Data maps that are necessary to run Vue.

Phase II: Working with Vue. In this section, we run the Vue software and explore the 
ecosystem services and canopy cover of our present and future urban forest.

Appendix: The appendix provides a detailed description of the limitations of i-Tree Vue, 
some technical notes, and information on how the underlying data were derived. 
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System Requirements

Minimum hardware:

• Pentium or compatible 1600 Mhz or faster processor

• 512 MB of available RAM

• Hard drive with at least 500 MB free space

Software:

• Windows XP service pack 2 or higher OS

• Adobe PDF Reader 9.0 (included in i-Tree installation)

Installation

To install Vue:

1  Visit www.itreetools.org to download the software or insert the i-Tree Installation 
CD into your CD-ROM drive. 

2  Follow the on-screen instructions to run the itree_setup.exe file. This may take 
several minutes depending on which files need to be installed. 

3  Follow the Installation Wizard instructions to complete the installation (default 
location recommended). 

Exploring Vue With the Sample Project

If you would like to begin exploring Vue’s capabilities, you can skip to Phase II: Working 
with Vue and use the sample projects that are included. Otherwise, move on to Phase I to 
gather the NLCD maps you’ll need to analyze your own urban forest. 

Installation

http://www.itreetools.org
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You’ll need to procure three images for your study area from the National Land Cover 
Datasets (NLCD): land cover, percent impervious cover, and percent tree canopy.  

MRLC Consortium Viewer

The MRLC Consortium Viewer is the gateway to obtaining the necessary images. To get 
started, turn off any pop-up blockers on your web browser, go to http://gisdata.usgs.net/
website/MRLC/ and review the user instructions. 

1  Click Launch MRLC Consortium Viewer to begin.

2  Use the Zoom tool to focus the window tightly on your study area.

3  You can use the categories under Display, such as Places, Transportation, 
Boundaries, and Hydrography, to help you clarify your boundaries. Click the green 
arrow to the left of the category to view the options and then check the boxes to 
show the information on the map.

4  Once you have focused on your study area, click the Download tab on the right, 
click the arrow next to Land Cover and select only these layers:
 
NLCD 2001 Land Cover  
NLCD 2001 Canopy (Tree Cover) 
NLCD 2001 Impervious Surface

5  Use the rectangular Download tool from the toolbar group on the left to draw a box 
around the final download area on the map. Note: Do not drag the tool beyond the 
map edges as this causes a reset of the viewer.

6  A pop-up window appears. Make sure that all three datasets are present in the 
download window because the three images must be downloaded at the same 
time with the exact same extents. For each layer, click Download and the Save 
File window will appear. Click Save and navigate to the location where you 
want the folder stored and change the default name to Land_cover, Canopy, or 
Impervious_Surface as appropriate.

7  Unzip each folder into your preferred location. Make a note of where the folders 
are stored; you’ll need this for Phase II. Each folder includes a metadata file (in 
.html format) that provides all of the background information on the data. The 
land cover metadata file includes the key for matching land cover types with their 
numerical codes. 

Phase I: Getting Started

http://gisdata.usgs.net/website/MRLC/
http://gisdata.usgs.net/website/MRLC/
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Clip NLCD data by a boundary polygon (for advanced users)

If you have access to ArcGIS with Spatial Analyst extension, you can use it to “clip” the 
NLCD images to include only your study area.

1  Make sure Spatial Analyst is available:

a  In the main toolbar, choose Tools > Extensions > Spatial Analyst.

b  Open the ArcToolBox panel using the ArcToolBox button under the main 
menu.

2  Extract the area for each of the three NLCD images:

a  ArcToolBox > Spatial Analysis Tools > Extraction > Extract by mask 
(with city polygon as the mask).

3  Export the extracted data:

a  Right-click layer name > Data > Export Data.

b  Change location for the exported data (remembering to only single click on 
the output folder location).

c  Change format to TIFF.

d  Adjust name as needed.

e  Leave other options at defaults.

4  Create a World File (*.TFW) for each of the 3 NLCD images:

a  ArcToolBox > Data Management Tools > Raster > Raster Properties > 
Export Raster World File.
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To begin working with Vue:

1  Click your computer’s Start menu > (All) Programs > i-Tree > Vue.

2  The Browse for NLCD Imagery window will appear. 

a  If you have gathered your own images using the steps in Phase I, click the 
Browse button for land cover, tree canopy, and impervious cover images 
and navigate to the locations where you saved each file. 

b  If you want to explore using a sample project, the image files are located in 
the folder where you installed Vue, most likely C:\Program Files\i-Tree\Vue\ 
in folders with names beginning SAMPLE_.

3  Once all three images have been loaded, select the correct state from the drop-
down menu at the bottom and click OK. The image processing will begin.

Understanding the Vue Layout

Main windows

The NLCD images appear in the top left, top right, and bottom left corners of the window. 
The bottom right corner is reserved for the output you select. We’ll return to that in just a 
minute. 

Map controls

The map controls are found at the bottom left of the screen and allow you to change the 
level of zoom, turn on and off scroll bars, and turn on and off the map legends. Check the 
metric units box if desired. Each image can be maximized by clicking the blue square in its 
top right corner.

Tabs panel

Along the right side of the screen, tabbed pages of statistics are presented. The General 
tab presents tree canopy and impervious cover (in acres and percent) across your 
study area and for the general land cover categories. The next six tabs present a more 
detailed look at the land cover types. The Pixel Info tab enables you to get a closer 
look at the composition of individual 30 x 30 m pixels. If you move your mouse over one 
of the images, the land cover, tree canopy, impervious cover and selected ecosystem 
services provided by trees within that pixel will be presented. The Classes tab provides 
a description of the NLCD land cover classes. The About tab includes links to several 
documents to provide more information and the Help tab offers general instructions.

Phase II: Working With Vue
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The tabbed reports can be viewed in printable form by clicking the notepad icon in the top 
right corner.

Analysis Options

The Analysis Options drop-down list at the bottom right of the screen is the core of the Vue 
program. It offers written reports and corresponding map images for a number of 
ecosystem services and several options for exploring different planting scenarios. The 
output reports begin with an initial window that allows you to make adjustments based on 
locally available data. Once this has been completed or the default options have been 
accepted, the output image will appear it the bottom right corner of the main window and a 
written report will appear in a pop-up window in a “tree” or outline form. Click the plus 
signs to open new levels or click Expand All to view all results in a given report at once. 
The written report can also be accessed via the notepad icon in the bottom right corner of 
the output window.

Adjusting per acre values and monetary equivalents

The first window that appears for each output allows you to adjust the state or national 
average data that Vue uses to calculate ecosystem services if desired. For example, 
carbon storage on a per acre basis is estimated using a national average of 9.1 kg C/
m2 or 81,188.3 lbs C/acre and a monetary value of $20.68/ton. If you have better local 
information you can edit as desired. 

For the ecosystem services reports, the adjustment window appears before the results are 
presented. Simply make any desired changes before clicking OK. For the canopy cover 
reports, you can enable the editing option by checking any of the boxes in the bottom right 
of the initial window. 

NOTE: To estimate benefits for different canopy cover scenarios, you must check the 
boxes next to the desired benefits. You can edit or accept the defaults.

Ecosystem services

There are seven ecosystem services reports that describe the benefits of the existing 
urban forest. Keep in mind that in each case, the results refer to the benefits derived from 
the trees. So, for example, when carbon storage is reported for the agricultural land cover 

Usage note: Output processing time is system dependent. On slower machines, 
processing may take several minutes. The output processing progress is shown by a 
progress bar at the bottom of the screen. Occasionally, this progress bar will appear to 
stall due to other system activity on your computer. You should NOT exit the program 
at this point. Instead, wait a few more minutes for the processing to complete.
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class, this refers only to the carbon storage of trees within that land cover class, not to the 
total carbon stored in soil, crops, etc. 

Carbon storage: The carbon storage output report estimates the total carbon (and 
carbon dioxide equivalents) stored in the total urban forest. Results are also presented 
for each land cover type. 

Carbon sequestration: The carbon sequestration report estimates the annual carbon 
(and carbon dioxide equivalents) sequestered each year by the urban forest. Results 
are also presented for each land cover type.

CO pollution removal: The CO pollution removal report estimates the amount of 
carbon monoxide removed by the urban forest annually. Results are also presented for 
each land cover type.

NO2 pollution removal: The NO2 pollution removal report estimates the amount of 
nitrogen dioxide removed by the urban forest annually. Results are also presented for 
each land cover type.

O3 pollution removal: The O3 pollution removal report estimates the amount of ozone 
(smog) removed by the urban forest annually. Results are also presented for each land 
cover type.

SO2 pollution removal: The SO2 pollution removal report estimates the amount of 
sulfur dioxide removed by the urban forest annually. Results are also presented for 
each land cover type.

PM10 pollution removal: The PM10 pollution removal report estimates the amount 
of small particulate matter removed by the urban forest annually. Results are also 
presented for each land cover type.

Canopy Cover Reports

There are six canopy cover reports: two describe existing conditions and four allow you to 
explore the effects of increasing or decreasing canopy cover.

Tree canopy stocking: The canopy stocking report presents the total tree canopy in 
acres and percent for your study area. Results are also presented for each land cover 
type.

Tree available growing space: The available space report estimates the amount 
of available planting space as the total area minus existing canopy cover minus 
impervious surface. Results are also presented each land cover type and for the total 
study area.

Tree canopy % change: The four canopy % change reports allow you to explore 
different planting scenarios by entering a desired canopy cover level. The Region 
report adjusts canopy cover evenly across the study area. The Developed, All report 
allows you to increase (or decrease) canopy cover equally across developed areas 
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while leaving canopy levels in other land cover types as it is. The Developed, Classes 
report allows you to target canopy cover changes to developed areas of different 
intensities, considering for example that a very dense urban core will have a lower 
canopy cover target than suburban areas. The General Classes report allows you to 
target canopy cover changes across broad land cover categories.

Printing and saving results

For written reports, the print and save options are available at the bottom of each report. 
Clicking Print will print reports directly to your default printer in the state in which they 
appear on the screen, i.e., where nodes are hidden, the results will not appear. The Save 
option results in a comma-delimited text file. 

To save the output image file and the corresponding NLCD images, click the Save Output 
button at the bottom right of the main window. Navigate to the desired location, give the 
file a name and click Save. A .tif file with the image and a .tfw worldfile for use in GIS 
programs will be saved. 
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Appendix: Limitation and Data Notes

Limitations

i-Tree Vue (beta) is a new program still in development that provides broad estimates of 
tree cover and some urban forest ecosystem services without requiring the user to collect 
field data. As this program does not require field data collection, the estimates can only be 
considered very coarse approximations with some significant limitations on the data and 
estimates. 

Despite these limitations, the i-Tree Vue is designed to provide easy first-order estimates 
of ecosystem services for urban areas. These data can used to view differences in 
existing cover and services, potential changes in benefits with changes in tree cover, and 
to provide a stepping stone to more accurate estimates of services through i-Tree Eco or 
i-Tree Streets. These data should not be considered final or accurate estimates of urban 
tree cover or environmental services.

Generalized estimates

The basic approach to i-Tree Vue is to use spatial tree cover maps developed by the 
National Land Cover Database (NLCD) (http://www.mrlc.gov/) and apply average 
ecosystem service values per unit of canopy cover to estimate services of the local area. 
This generalized approach using national or state averages has significant limitations at 
the local scale.

NLCD tree cover estimates

NLCD provides tree cover estimates within 30-meter pixel resolution for the contiguous 
United States. This national database provides important information on our national tree 
resources, but has limitations, particularly at the local scale. Tree cover estimates from 
the NLCD cover maps are believed to underestimate tree cover by an average of about 
10 percent (Greenfield et al., in press). However, the degree of underestimation varies 
across the nation. Thus, the tree cover and consequently the ecosystem service estimates 
in cities and towns are likely conservative, but the degree of underestimation in specific 
locations is unknown. Better estimates of tree cover can be obtained through aerial photo 
interpretation or the development of higher resolution tree cover maps using LIDAR 
technology (e.g., http://www.nrs.fs.fed.us/urban/utc/).

Air pollution removal estimates

To more accurately estimate pollution removal in a city, local pollution and weather data 
are needed, as well as local estimates of the leaf area index (depth of canopy) and canopy 
cover. As local data are unknown in i-Tree Vue (except for the estimate of tree cover), 
i-Tree Vue uses state average estimates of annual pollution removal per square meter 
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of tree cover (g/m2/yr) to estimate local pollution removal assuming a leaf area index of 
6 [i.e., 6 m2 of leaves (one-sided) per m2 of canopy cover]. As pollution concentrations, 
weather, and urban forest leaf area indices can differ significantly at the local level, i-Tree 
Vue estimates are coarse at best. The closer your area conditions are to the state average 
and a leaf area index of 6, the closer the i-Tree Vue estimate will be for your area. Better 
estimates can be obtained by collecting local field data and using i-Tree Eco or i-Tree 
Streets. More information on how air pollution removal was calculated are given below.

Carbon storage and sequestration estimates 

To more accurately estimate carbon storage (amount of carbon currently in trees) and 
annual carbon sequestration (amount of carbon removed in one year) in a city, local 
environmental conditions (e.g., tree competition, length of growing season) and tree 
density, species, and diameter distribution information are required. As local tree data 
are unknown in i-Tree Vue (except for the estimate of tree cover), i-Tree Vue uses 
national average estimates to approximate local carbon effects. Carbon sequestration 
and storage values are estimated from tree cover (m2) multiplied by average carbon 
storage (9.1 kg C/m2), and sequestration (0.3 kg C/m2) density values derived from several 
U.S. communities (e.g., Nowak and Crane 2002, Nowak and Greenfield 2008). As tree 
population and environmental variables can differ significantly at the local level, i-Tree Vue 
estimates are coarse at best. The closer your area conditions are to the group average, 
the closer the i-Tree Vue estimate will be for your area. Better estimates can be obtained 
by collecting local field data and using i-Tree Eco or i-Tree Streets. 

Dollar value estimates

Monetary estimates of ecosystem services are based on literature estimates of values 
per ton of pollution or carbon. Monetary values associated with urban tree carbon storage 
and sequestration were based on the 2001–2010 projected marginal social cost of carbon 
dioxide emissions, $22.8/t C (Fankhauser 1994). Pollution-removal dollar value estimates 
were calculated using 1994 national median externality values used in energy decision 
making (Murray et al. 1994, Ottinger et al. 1990). The 1994 values were adjusted to 2007 
dollars based on the producer price index (U.S. Dept. of Labor 2008). These values, in 
dollars/metric ton (t) are as follows: nitrogen dioxide (NO2) = $9,906/t, particulate matter 
less than 10 microns (PM10) = $6,614/t, sulfur dioxide (SO2) = $2,425/t, carbon monoxide 
(CO) = $1,407/t. Externality values for ozone (O3) were set to equal the value for NO2. 
Externality values can be considered the estimated cost of pollution to society that is not 
accounted for in the market price of the goods or services that produced the pollution. 

NLCD Imagery Technical Notes

NLCD image data are stored as values from 0 to 100 in each image pixel. As such, results 
of the new tree canopy estimates are necessarily rounded. This rounding has the potential 
to skew user-defined tree cover estimates in the output tree canopy dataset by up to one 
percent. This skewing is more pronounced when dealing with a region or land use that 
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covers a very small area of interest. In addition, carbon and pollution values are not actually 
stored in the image pixels as rounding them would reduce their usefulness. Instead, tree 
canopy—existing or new estimates—are stored in the image pixels. Within i-Tree Vue, the 
carbon and pollution values are then computed on the fly for display in the pixel information 
windows. After export of carbon or pollution images, you can multiply the stored tree canopy 
values by your chosen carbon and pollution values in your GIS program. 

Projection System 

See www.mrlc.gov or the metadata files that came with the images for more information: 

Projection ALBERS 
Datum NAD83  
Spheroid GRS80  
Units METERS  
Zunits NO  
Xshift 0.0  
Yshift 0.0  
Parameters  
29 30 0.0 /* 1st standard parallel  
45 30 0.0 /* 2nd standard parallel  
-96 0 0.0 /* central meridian  
23 0 0.0 /* latitude of projection’s origin  
0.0 /* false easting (meters)  
0.0 /* false northing (meters) 

Air Pollution Removal Methods

Air pollution removal estimates are derived from the Urban Forest Effects (UFORE) model 
(Nowak and Crane 2000) and 2000 weather and pollution data (National Climatic Data 
Center 2000, U.S. EPA 2008). The UFORE model was used to integrate hourly pollution 
and weather data with urban or community tree cover data to estimate annual pollution 
removal in each state (Nowak and Crane 2000, Nowak et al. 2006). 

To estimate pollution by urban trees in each state, state pollutant flux rates (grams of 
pollution removal per square meter of canopy per year) were derived from a study of 
national pollution removal by urban trees for the year 1994 (Nowak et al. 2006). As 
pollution concentrations vary through time, the 1994 flux rates were adjusted to 2000 
values based on average regional pollution concentration changes between 1994 and 
2000 (U.S. EPA 2003). As flux rate = deposition velocity * pollution concentration, the ratio 
of the pollution concentration between years was used to update the flux rate. 

Arithmetic mean concentration values were used for nitrogen dioxide, particulate matter 
less than 10 microns, and sulfur dioxide; 2nd max. 8-hr average for carbon dioxide; and 
4th max. 8-hr average for ozone, to determine the ratio of change between 1994 and 2000 

www.mrlc.gov
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(U.S. EPA 2003). The new 2000 flux rates are multiplied by urban or community tree cover 
to estimate total pollution removal by trees.
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